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Preface
The purpose of this guide is to help NetBackup system administrators install and 
configure NetBackup™ DataCenter. The NetBackup system administrator is responsible 
for maintaining backups and disaster recovery plans using NetBackup.

This guide assumes:

� A basic understanding of Microsoft Windows system administration.

� Experience with the system on which NetBackup is to be installed.

� Your SCSI devices are properly attached and configured for the operating system.

Caution If a device is not properly configured for the operating system, backups made to 
that device may lead to data loss.

Organization
This manual steps through installing and configuring your NetBackup software by using 
a step-by-step checklist. The checklist appears on the first page of each chapter:

� Chapter 1, “Installation and Initial Configuration,” contains instructions for installing, 
upgrading, and configuring the software.

� Chapter 2, “Uninstall/Reinstall NetBackup and Clients” contains instructions for 
uninstalling and reinstalling the NetBackup software.
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Accessibility
Accessibility 
NetBackup contains features that make the user interface easier to use by people who are 
vision impaired and by people who have limited dexterity. Accessibility features include:

� Support for assistive technologies such as screen readers and voice input (Windows 
servers only)

� Support for keyboard (mouse-less) navigation using accelerator keys and mnemonic 
keys

For more information, see the NetBackup system administrator’s guide.

Conventions
The following explains typographical and other conventions used in this guide.

Type Style

Notes and Cautions

Note This is a Note. Notes are used to call attention to information that makes using the 
product easier or helps in avoiding problems.

Caution This is a Caution. Cautions are used to warn about situations that could cause 
data loss.

Table 1. Typographic Conventions

Typeface Usage

Bold fixed width Input. For example, type cd to change directories.

Fixed width Paths, commands, filenames, or output. For example: The default installation 
directory is /opt/VRTSxx.

Italics Book titles, new terms, or used for emphasis. For example: Do not ignore cautions.

Sans serif (italics) Placeholder text or variables. For example: Replace filename with the name of your 
file.

Serif (no italics) Graphical user interface (GUI) objects, such as fields, menu choices, etc.

For example: Enter your password in the Password field.
viii NetBackup DataCenter Installation Guide for Windows



Conventions
Key Combinations

Some keyboard command sequences use two or more keys at the same time. For example, 
holding down the Ctrl key while pressing another key. Keyboard command sequences are 
indicated by connecting the keys with a plus sign. For example:

Press Ctrl+t

Command Usage

The following conventions are frequently used in the synopsis of command usage.

brackets [ ]

The enclosed command line component is optional.

Vertical bar or pipe (|)

Separates optional arguments from which the user can choose. For example, when a 
command has the following format:

command arg1|arg2

the user can use either the arg1 or arg2 variable.

Terms

The terms listed in the table below are used in the VERITAS NetBackup documentation to 
increase readability while maintaining technical accuracy. 

Term Definition

Microsoft Windows, 
Windows

Terms used as nouns to describe a line of operating systems 
developed by Microsoft, Inc. 

A term used as an adjective to describe a specific product or 
noun. Some examples are: Windows 95, Windows 98, 
Windows NT, Windows 2000, Windows servers, Windows 
clients, Windows platforms, Windows hosts, and Windows GUI.

Where a specific Windows product is identified, then only that 
particular product is valid with regards to the instance in which 
it is being used. 
For more information on the Windows operating systems that 
NetBackup supports, refer to the VERITAS support web site at 
http://www.support.veritas.com.
Preface ix



Getting Help
Getting Help
For updated information about this product, including system requirements, supported 
platforms, supported peripherals, and a list of current patches available from Technical 
Support, visit our web site:

http://www.support.veritas.com/

VERITAS Customer Support has an extensive technical support structure that enables you 
to contact technical support teams that are trained to answer questions to specific 
products. You can contact Customer Support by sending an e-mail to 
support@veritas.com, or by finding a product-specific phone number from the VERITAS 
support web site. The following steps describe how to locate the proper phone number.

1. Open http://www.support.veritas.com/ in your web browser.

2. Click Contact Support. The Contacting Support Product List page appears.

3. Select a product line and then a product from the lists that appear. The page will 
refresh with a list of technical support phone numbers that are specific to the product 
you just selected.

Windows servers A term that defines the Windows server platforms that 
NetBackup supports; those platforms are: Windows NT and 
Windows 2000.

Windows clients A term that defines the Windows client platforms that 
NetBackup supports; those platforms are: Windows 95, 98, ME, 
NT, 2000, XP (for 32- and 64-bit versions), and LE.

Term Definition (continued)
x NetBackup DataCenter Installation Guide for Windows



NetBackup Basics
 1

This chapter is designed to provide you with a basic understanding of the features and 
functions of your product. Included are definitions of a few key NetBackup terms to assist 
you in this process. 

Installing NetBackup DataCenter software on the server and NetBackup client software 
on each of your remote computers provides an easy-to-use, reliable solution for backing 
up and restoring data.

How does NetBackup DataCenter work?
NetBackup DataCenter has three primary functions, it: 

� Enables users to create backup policies to back up your data

� Saves backup catalogs and stores the data until you need to retrieve it

� Retrieves the data you have stored while providing a robust recovery tool should a 
disaster occur.

What is a backup policy?
A backup policy allows you to configure how and when backups are to be performed for 
your group of clients, all having similar backup requirements. Your backup policy will be 
configured when you determine:

� Which computers to back up

� Which files and folders to back up

� How often and when the backup takes place

� How long the backup will be retained 

� Where the backups are stored

� Other attributes for customizing the backup
1



How does NetBackup DataCenter work?
What are Catalog Backups?
NetBackup keeps vital information about your (regular) backups in a set of files called a 
catalog. Catalogs can be in two formats, ASCII and binary, and contain information 
about configuration, status, errors, and the files and folders that have been backed up. The 
catalog also keeps track of the location of the backed-up data. 

NetBackup provides an enhanced catalog format designed to improve the scalability 
and performance of catalog access in NetBackup. This binary catalog format feature will 
improve catalog performance for browsing and searching the on disk catalogs, and in 
some cases reduce the catalog file size. The new binary catalog format is written by 
NetBackup on all platforms except for NCR and Sequent. (For more information about 
the new catalog format feature, see the system administrator’s guide.)

A catalog backup is a backup copy of the catalog, which is necessary for NetBackup 
operations. For example, if a disk failure results in the loss of your catalog files, the easiest 
way to recover is to restore the catalog from its backup copy. This copy allows you to 
restore previously backed up data and resume your regularly scheduled backups. The 
process of backing up a catalog is the same for either catalog format. 

What are the functional parts of NetBackup?
We will now describe the parts of NetBackup. The terms and features listed here are basic 
to your understanding of how NetBackup DataCenter works.

The following diagram shows the basic architecture of a DataCenter configuration. where 
your data goes, the backup and restore operations can be visualized in a diagram on the 
following three pages. The following subsections describe each of the major pieces within 
this configuration.
2 NetBackup DataCenter Installation Guide for Windows



How does NetBackup DataCenter work?
Master Server 

The Master Server is the computer where NetBackup DataCenter software is installed. 
There can be only one Master Server per backup domain. The Master Server, with 
NetBackup installed, is responsible for the following functions:

� Contains the back-up configurations and policies

� Runs the Scheduler that initiates the automated backups

� Maintains databases/catalogs that track the location and contents of all backups
Chapter 1, NetBackup Basics 3



How does NetBackup DataCenter work?
� Communicates with Media Servers to initiate backups and restore processes

� Provides both a command line interface and a graphical user interface, which allow 
you to:

- Configure the backup operations.

- Schedule automatic, unattended backups (regular backups). For example, to 
prevent interference with normal daytime operations, you can schedule your 
automatic backups to occur only at night.

- Perform manual backups of any client.

- Allow client users to perform their own backups and restores.

- Control where backups are stored.

- Control how long backup data is retained.

- Restore data to any client.

- Run reports to verify, manage, and troubleshoot backups and restores. These 
reports show status or highlight problems with NetBackup servers and clients.

- Monitor the status of backup and restore jobs. 

- Configure and manage your tapes and storage devices.

Media Servers

A Media Server, in a DataCenter configuration, can be standalone server that receives 
requests for backup and restore operations from the Master Server. (A master server can 
also be configured as a media server.) There can be multiple Media Servers in a backup 
domain. Media Servers can:

� Communicate with the Media Manager (on the same system) to select media for 
backup and restore operations. Refer to “Media Manager” on page 7 for more 
information.

� Communicate with NetBackup Clients during a backup or restore operation

� Monitor the status of storage devices
4 NetBackup DataCenter Installation Guide for Windows



How does NetBackup DataCenter work?
NetBackup Clients

NetBackup Clients are the remote computers that have NetBackup client software installed. 
There can virtually be an unlimited number of clients for each backup domain. With the 
proper conditions set, a client can direct a user request to the Master Server to perform a 
backup or restore operation. Clients can:

� Validate connection requests from the NetBackup server

� Support compression of backup stream

� Support include and exclude lists

In general, these computers can be any combination of the following:

Disk Storage Unit

A disk storage unit is a term that describes a storage device where NetBackup or Storage 
Migrator stores files and data. A storage unit can be a location on a disk, a set of drives in 
a robot, or one or more single tape drives of the same type that connect to the same host. 

AIX Macintosh
Compaq Tru64 NCR SVR4MP-RAS
DG/UX NetWare
DYNIX/ptx OS/2
HP-UX Solaris
IRIX Windows 95/98/ME/NT/2000/XP (32 and 64 bit)/LE 
Linux
Chapter 1, NetBackup Basics 5



How does NetBackup DataCenter work?
In the following diagram, the storage unit node is listed in the tree in the left window 
pane and the specific units will appear in the right pane.

Storage units simplify administration because once they are defined the NetBackup 
configuration points to a storage unit rather than to the individual devices it contains. For 
example: if a storage unit contains two drives and one is busy, NetBackup can use the 
other drive without administrator intervention.

Media

Media are physical magnetic tapes, magnetic disks (also called removable media), or 
optical disks where data can be stored. Non-removable media commonly referred to as 
“hard disk share” is usually a directory on a hard disk. 
6 NetBackup DataCenter Installation Guide for Windows



How does NetBackup DataCenter work?
Media Manager
Media Manager, which is part of NetBackup, manages the robots, tape drives, and their 
removable media. Media Manager primarily uses four tools:

� The Device Configuration Wizard, which guides you through device configuration in 
a step-by-step manner. 

� The Volume Configuration Wizard, which guides you through volume configuration 
in a step-by-step manner.

� The Media and Device Management graphical interface, which allows you to 
reconfigure storage devices and volumes separately.

� The Device Monitor graphical interface, which displays any pending requests for 
volumes and allows you to control and manage your devices.

Graphical Interfaces 
NetBackup uses the following graphical interfaces:
Chapter 1, NetBackup Basics 7



How does NetBackup DataCenter work?
The NetBackup Administration Console is used for configuring, scheduling, monitoring, 
and managing NetBackup.

The NetBackup user interface, which is on each client, can be used for starting backups, 
managing archives, and initiating restores for that particular computer.
8 NetBackup DataCenter Installation Guide for Windows



How does NetBackup DataCenter work?
NetBackup Wizards
NetBackup DataCenter provides the following wizards to assist you with installation and 
configuration. Once you have completed your initial setup with the Getting Started 
wizard, the individual configuration wizards allow you to reconfigure devices, volumes, 
catalog backups, and backup policies separately as needed.

Wizards Description

Getting Started Provides step-by-step help for configuring NetBackup. By 
responding to a series of prompts, the Getting Started 
wizard guides you through the following procedures for 
initial setup:

� Device Configuration

� Volume Configuration

� Catalog Backup Configuration

� Backup Policy Configuration

� A test to verify your configuration

Configure Storage Devices Helps you define robots and drives.

Configure Volumes Helps you define volumes for robots and standalone 
drives.

Configure Catalog Backup Helps you configure how and when the NetBackup 
catalog is backed up.

Create a Backup Policy Helps you configure regular backups for a client or a set 
of clients.

Import Images Assists you in stepping through an import.

Configure a Shared Drive Helps you configure a new shared drive or reconfigure an 
existing shared drive.
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How does NetBackup DataCenter work?
Multiple Data Streams
NetBackup DataCenter can be configured to use multiple data streams, which allow you to 
back up more than one file or directory on a client at the same time, using a single backup 
policy. 

For example: assume you have a remote computer with NetBackup client software 
installed and this computer has two hard drives. If you want to perform a fast nightly 
backup of these drives, you can configure NetBackup DataCenter to back up both drives 
at the same time.

Multiplexing
Multiplexing allows backups from more than one client to be sent to the same storage 
device at the same time. Multiplexing interleaves each block of backup data onto a storage 
device. The figure on the left illustrates data being backed up for one client. The figure on 
the right illustrates how data streams from two clients are stored by multiplexing.
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Installation and Initial Configuration
 2

Installing and configuring NetBackup involves the following steps as explained in this 
chapter:

� Configuring Storage Devices for Windows

� NetBackup Server Software

� Performing an Upgrade Installation

� Configuring NetBackup Server Software

� NetBackup Client Software 

� Installing Alternative Administration Interfaces (Optional)

� Installing NetBackup Java Windows Display Console

� Installing NetBackup Agents and Options (Optional)
11
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Configuring Storage Devices for Windows 
Reliable use of NetBackup depends on the proper configuration of your storage devices. 
To ensure reliable backups and restores, you must configure devices for Windows 
according to the instructions provided by the device vendor and by Microsoft. This 
should be completed before you configure NetBackup itself.

Supported Robot Types 
See "Robot Type Support By Platform" in the NetBackup Release Notes for a list of the 
supported robot types. 

You can see a list of supported devices by vendor, by visiting the VERITAS support web 
site.

1. Open www.support.veritas.com in a web browser.

2. Click SUPPORT in the horizontal-navigation bar, near the top of web page. The 
VERITAS Support page appears. 

3. Click Compatibility Lists in the left navigational field. The Online Compatibility Lists 
page appears.

4. Click +NetBackup Products. A list of NetBackup products appears below the 
NetBackup Product that you selected.

5. Select a NetBackup product from the list and click on the product name. The 
corresponding NetBackup page appears.

6. Click Device Support Matrix from within the Compatibility Lists - Version Selection 
field. A list of product releases appears.

7. Click on the product name and version for which you want information. A list of 
supported devices organized by vendor appears. You can also display all supported 
drives, libraries, and robot types.

Caution An improperly configured device may lead to loss of data during a restore.
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Storage Device Configuration 

1. Complete all of the configuration steps specified by the storage device vendor and by 
Microsoft.

2. After you have configured your storage device you are ready to begin the installation 
of the NetBackup DataCenter software. 

Note When installing NetBackup for the first time, VERITAS recommends that you install 
the latest device drivers for your storage device immediately after you install the 
NetBackup software and before you configure the product. 

If you are upgrading NetBackup, you can install the latest device drivers before you 
upgrade NetBackup. 

The VERITAS Tape Device Driver Install wizard (preloaded on your CD-ROM) will 
step you through the process of installing the latest device drivers. Steps a through c 
describe how to initiate this wizard.

If you do not have a CD-ROM, you can download the NetBackup Tape Device 
Driver Install software from the VERITAS support web site. 

http://www.support.veritas.com

a. Log in as Administrator on the server where you will be installing NetBackup.

b. Insert the NetBackup CD-ROM in the drive.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the 
VERITAS NetBackup installation browser starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

c. In the VERITAS Browser, click Additional Product Installations > NetBackup 
Tape Device Driver link. The NetBackup Tape Installer wizard appears.
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3. Follow the prompts throughout this wizard to install the latest device drivers for your 
storage device.

Note As VERITAS supports more devices, you can download the latest external device 
mapping files on the Updates and Patches web page on the VERITAS support web 
site: http://www.support.veritas.com.

4. After you complete this installation, you are ready to configure the NetBackup 
DataCenter software.

NetBackup Server Software 
This section prepares you for the installation of your NetBackup product. It is important 
that you ensure all NetBackup servers are at the same release level, and this release level is 
at least equal to the version level on the clients. (Older versions of server software can 
encounter problems with newer clients.)

VERITAS recommends that you upgrade in the following order:

a. Master Server

b. Media servers, if any 

c. NetBackup Remote Administration Console, if any

d. NetBackup clients

e. Any NetBackup Add-on products (such as NetBackup for Oracle) 

Server Installation Requirements 
Installing the server software takes approximately 10 minutes (additional time may be 
required to set up the product for your environment). Before installing, note the following 
requirements:

Note VERITAS recommends that you remove any other vendor’s backup software 
currently configured on your system before installing this product. Other vendor’s 
backup software can negatively effect how NetBackup installs and functions.

Caution Before installing your NetBackup product, make sure you have the most 
current operating system patches and updates applied to your system. If you 
are not certain of your OS level, contact your OS vendor and request the latest 
patches and upgrades.
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� An Intel Pentium system running Microsoft Windows NT version 4.0 with service 
pack 6A installed, or Windows 2000 with a minimum of 64 MB of memory and service 
pack 2 installed.

� Requires a browser level of Internet Explorer 5.5 as a minimum.

� An administrator account and password for the server.

� Adequate disk space:

- Intel server software requires approximately 180 megabytes.

- On-line documentation, if you choose to install it, requires about 60 megabytes.

- NetBackup catalogs contain information about your backups and will increase in 
size as you use the product. The amount of disk space the catalogs require 
depends primarily on the number of files backed up, the frequency of your 
backups, and the amount of time you chose to retain your backup data. VERITAS 
suggests that you allow a minimum of 250 megabytes.

Note VERITAS recommends that you have a total of 490 megabytes of storage space to 
accommodate the NetBackup server software as well as the NetBackup catalogs.

- A NetBackup installation partition that supports long file names. VERITAS 
suggests an NTFS partition.

- An additional 100MB of memory is necessary on the drive where Windows is 
installed during the installation or upgrade process. After the install or upgrade is 
complete, this additional space is no longer needed.

� Peripherals, such as robotic devices and stand-alone tape drives, installed according 
to the manufacturers’ instructions and recognized by the Windows software.

� The network is configured so the computers recognize and communicate with one 
another. Generally, if you can reach the clients from the server by using the ping 
command, the setup will work with NetBackup.
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Server Installation Notes 

NetBackup Services and Port Numbers

VERITAS suggests that you use the default port settings for NetBackup services and 
Internet service ports. If you modify the port numbers, they must be the same for all 
NetBackup systems that communicate with each other (that is, all master servers, media 
servers, and clients). The port entries are in the following file:

%SYSTEMROOT%\system32\drivers\etc\services

To change the default settings, you must perform a Custom Installation of NetBackup.

Client Software

Installing NetBackup server software also installs client software on the server system. 
However, installing NetBackup on client systems is done separately as described in the 
NetBackup Installation Guide - PC Clients.

Add-on Products

If you are installing NetBackup add-on products, such as NetBackup for Microsoft SQL 
Server, refer to the installation instructions that came with the software.

System Names

If you install NetBackup Remote Administration Consoles, the master server must have 
the system names of the NetBackup Administration Consoles in its server list to allow 
them access.

Additional Note to DataCenter Users:

� For instructions on verifying and changing the server list, and installing media 
servers, see Appendix C of your NetBackup administrator’s guide: NetBackup 
DataCenter System Administrator’s Guide for Windows 

� If you are not adding any NetBackup media servers, ignore all references to media 
server throughout the installation process.
16 NetBackup DataCenter Installation Guide for Windows



NetBackup Server Software
Installing the Server Software 

� To install NetBackup server software

1.  When installing a NetBackup server, master or media, you must enter a NetBackup 
base product license key on the server. You will also enter license keys for any 
additional NetBackup software product options or agents used on the server or its 
clients. All product license keys must be entered on the master server.

Check your order to make sure that you have license keys for all the NetBackup 
servers, clients, options, and agents that you requested.

For more information on administering NetBackup licenses refer to NetBackup 
DataCenter System Administrator’s Guide for Windows.

Note When making and saving any license key updates (including adding and deleting 
license keys) in the NetBackup Administration Console, you must restart the 
NetBackup Administration Console. 

2.  Log in as Administrator on the server where you will be installing NetBackup.

3. Insert the NetBackup CD-ROM in the drive.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS 
NetBackup installation browser starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

4. On the NetBackup - CD browser, click on the NetBackup Installation option in the 
main window. The contents of the main browser window will display the following 
information and options:

- Links on the left side of the browser that display information pertaining to 
NetBackup, Database Agents, and Additional Products.

- Browse the CD

- The NetBackup link selected (by default) and these available options:

- Begin NetBackup Installation

- View Certification Information

- View available documentation

- Link to VERITAS Technical Support

- Link to VERITAS e-Learning
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5. Click NetBackup Installation.The browser refreshes and displays pre-installation 
information.
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6. Click the appropriate link of the installation (client or server) that you want to start. 
The NetBackup Setup wizard begins.

7. Click Next. The NetBackup License Key and Server Type window appears. 

8. Enter the base product license key that you received when you purchased your 
product. The license key that you enter will determine which of the three installations 
are available for you to install. 

9. Select the type of installation that you want to perform. 

Note Installing NetBackup Remote Administration Console does not require a license 
key.

10. Click Next. The Setup Type window appears. You can elect to perform a typical or a 
custom installation. Refer to “Custom Installation Differences” to see the differences 
in the installation processes. 

11. Select Typical and then click Next. The NetBackup System Names window appears. 

From this window you can enter the names of the systems that will have access to this 
current system.

Note If installing a media server, the NetBackup System Names window will have an 
additional line with the local media server filled in. You must enter a Master Server 
name that this media server is configured to.
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12. Enter the server names and click Next. The NetBackup Global Device Database Host 
window appears. 

13. Enter the name of the 
NetBackup Global Device 
Database Host, which serves 
as the repository for global 
device configuration 
information. For more 
information about the Global 
Device Database Host, see 
NetBackup dataCenter Media 
Manager System 
Administrator’s Guide for 
Windows.

Under most circumstances, 
this can be left as the default, 
which is the master server. 
However, you may need to 
enter a different host name in the following situations:

- If the system shares drives with the Shared Storage Option (SSO), all NetBackup 
servers must use the same host for storing device information.

- If the system has multiple master servers, enter the name of the server that will 
store the global device configuration information. Conflicting host information 
may result in an error. 

Note If you want to make changes to the installation settings, click the Back button until 
you reach the page where you can make the change, or click the Cancel button and 
exit the wizard.

14. Click Install. The installation process begins. This process could take several minutes.

Note After the installation completes, a NetBackup installation log file is generated. You 
can find this log file at your default TEMP directory. The following procedure 
explains how to verify your TEMP environment variable so you can locate the 
NetBackup Installation log file.
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� Locating the NetBackup Installation log file for Windows 2000 systems

a. Select Start > Programs > Accessories > Command Prompt. A Command Prompt 
window appears. 

b. Enter echo %TEMP% and press the Return key on your keyboard. The location of 
your TEMP directory will display.

� Locating the NetBackup Installation log file for Windows NT systems 

a. Select Start > Settings > Control Panel. The Control Panel window appears. 

Note Make sure you can view all hidden files and folders. To set this option, select Tools 
> Folder Options... in the Control Panel window. Then click the View tab; set the 
Show hidden files and folders option, and click the OK button.

b. Double-click the System icon. The System Properties window appears.

c. Click the Environment tab. The Environment Variables including the TEMP variable 
will appear along with the corresponding paths for each variable. 

15. Prior to clicking Finish, the NetBackup installation prompts you to continue the setup 
process and configure your product. By default the Launch NetBackup 
Administration Console now check box is selected. 

a. To continue this process and configure your product, click Finish. For more 
information on how to configure your product, see “Configuring NetBackup 
Server Software” on page 30

b. To wait and configure your product at another time, uncheck the Launch 
NetBackup Administration Console now option and then click Finish.

Note VERITAS recommends that you continue with the product setup and configuration 
by clicking the Getting Started link in the right pane of the NetBackup 
Administration Console and continuing through the list until you have completed 
the production configuration.
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Custom Installation Differences 
During the installation process of NetBackup you can chose between performing a typical 
or a custom installation. The typical installation uses predefined values and parameters 
when performing the installation. The custom installation enables the user to make 
modifications to specific parameters. This section briefly explains the changes that can be 
made. 

A custom installation begins the same as a standard installation, therefore all steps prior 
the Setup Type window (Step 9 in the previous procedure) are identical. This procedure 
begins after you have selected the Custom radio button on the Setup Type window.

1. From the Custom Setup window you can:

- Change which features are installed, such as: 

- NetBackup

- User Documentation

- Open Transaction Manager Documentation

- NetBackup Debugger Symbols

- Backup Exec Tape Reader for NetBackup

- Change the installation location of the NetBackup product.

Note By default, the Backup Exec Tape Reader feature is marked not to be installed on 
initial installation. 

From this window you can chose which product feature, and in some cases 
subfeatures, to install. To mark a feature as unavailable do the following:

a. Select the icon next to 
the feature that you 
want to change. A 
pop-up window 
appears. 

b. Click This feature will 
not be available. A red 
“X” appears in the icon 
signifying the feature 
will not be installed.
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c. Click Change to select a new location to install NetBackup. The Change Current 
Destination Folder window appears. This window enables you to browse to a new 
location and designate a new folder where NetBackup will be installed.

2. Click Next. The NetBackup 
Services window appears. 

From this window you:

- Enter a Username, 
Password, and Domain 
or check the Use the 
built-in system account 
check box.

- Chose a startup type to 
use for the NetBackup 
services

- Elect to start the services 
after install by selecting 
the Start NetBackup 
Server Services After Install checkbooks.

3.  Click Next. The NetBackup 
Services window for the 
Backup Exec Tape Reader 
services appears if Backup 
Exec Tape Reader for 
NetBackup is selected for 
installation.

From this window you will 
enter a user name, 
password, and domain for 
the Backup Exec Tape 
Reader services.

Note By default, the Backup 
Exec Tape Reader feature 
is marked not available on 
initial installation. For more information about installing the NetBackup Tape 
Reader, refer to the NetBackup DataCenter System Administrator’s Guide for Windows.
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4.  Click Next. The NetBackup 
Port Numbers window 
appears.

This window enables users 
to change port numbers if 
that is necessary. Some 
reasons a user may change a 
port number is if:

- A conflict exists between 
NetBackup and another 
industry product 
sharing the same port.

- A port conflict occurs 
with a company’s 
firewall causing security 
issues.

5. Click Next. The NetBackup System Names window appears. From this window you 
can define the master server and add additional servers that can access the system 
you are installing NetBackup on.

6. Click Next. The NetBackup Global Device Database Host window appears. 

7. Enter the NetBackup Global Device Database Host Name and click Next. The Ready 
to Install the Program window appears. 

Note If you want to make changes to the installation settings, click the Back button until 
you reach the page where you can make the change, or click the Cancel button and 
exit the wizard.

8. Click Install. The installation process begins. 
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9.  At the end of installation, 
the Completing the NetBackup 
wizard window appears. At 
this time you can click the 
Add Keys button to add 
additional NetBackup 
license keys.

10. Click Finish. 

By default, the NetBackup 
Administration interface 
automatically launches 
unless you uncheck the item 
labeled, Launch NetBackup 
Administration now.

For more detailed information about windows within this installation, refer to the 
NetBackup DataCenter System Administrator’s Guide for Windows.

Installing the Backup Exec Tape Reader for NetBackup 

Backup Exec Tape Reader enables users to read media from VERITAS Backup Exec media. 
It enables you to import catalogs, browse and select images, and restore data from 
NetBackup Exec media using NetBackup 4.5. 

Caution Before upgrading to NetBackup, the Backup Exec user interface should be used 
to attach to all the clients which may be restored from Backup Exec backups. 
This includes Windows machines which cannot be accessed by the user account 
under which the Backup Exec services are running, Netware machines, UNIX 
machines, the Exchange databases and mail boxes and SQL databases. Backup 
Exec will be able to restore file system backups to all those Windoows machines 
which can be accessed by the user account under which the Backup Exec 
services are running.

To install the Backup Exec Tape Reader you must perform a custom installation of 
NetBackup. As a part of the custom install, you will select Backup Exec Tape Reader. The 
installation will then prompt you to enter a user name and password to enable the 
services and install the feature. 

Note When you elect to install Backup Exec Tape Reader, you will encounter a separate 
start menu item that requires you to configure this feature.
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Silent Installation Instructions 
Performing a silent installation avoids the need for interactive input. In addition, this 
procedure will not allow you to change the install location. If you to change the install 
location you must go through the interactive installation described earlier in this 
document.

Note Silent installations of NetBackup are not supported if either of the following are 
true:

- You want to run the NetBackup services as a user rather than the local system.
- You want to install the BackupExec Tape Reader for NetBackup.

If you want to install NetBackup under either of these circumstances, you must go 
through the interactive installation described earlier in this document.

� To install NetBackup server software silently 

1. Install the Windows Installer service by double-clicking on the following executable 
on the CDROM (except for Windows 2000):

.\x86\instmsiw.exe

Note Skip this step for Windows 2000 systems. The Windows Installer service is already 
installed on these systems. 

2. Copy the contents of the .\Common directory on the CD-ROM to a temporary 
directory on your hard drive.

3. In that temporary directory, modify the appropriate script. (The following list shows 
the available items and the corresponding commands.)

- To install a master server, edit:

silentmaster.cmd

- To install a media server, edit:

silentmedia.cmd

- To install a NetBackup Remote Administration Console, edit:

silentadmin.cmd

4. If only one master server will be accessing the machine, remove the following line 
from the script:

SET ADDITIONALSERVERS=media1,media2,media3
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5. Save and run the script.

6. Check the log file (NetBackup Install.log in the default TEMP directory) to 
verify that the install was successful.

Note After the installation completes, a NetBackup installation log file is generated. You 
can find this log file at the default temp directory. To determine where your TEMP 
directory is located, refer to “Locating the NetBackup Installation log file for 
Windows 2000 systems” on page 21 or “Locating the NetBackup Installation log file 
for Windows NT systems” on page 21.

Note If this installation is an upgrade, you must reboot the computer for the changes to 
take effect.
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Performing an Upgrade Installation 

Caution Before you upgrade the NetBackup software on the master server:
– Back up your NetBackup catalogs.
– Verify that the backup was successful.

Notes and Requirements About Upgrading to 4.5 
� The NetBackup installation program detects an existing installation of NetBackup and 

allows you to upgrade or reinstall it as needed. A reinstall is useful if your installation 
is corrupted.

� You can upgrade to 4.5 only if you currently have NetBackup 3.4, 3.4.1, or 4.0V 
software installed.

� When installing Windows 2000 on a system that previously had a Windows 95, 98, or 
ME and NetBackup installed, VERITAS recommends that you reinstall NetBackup 4.5 
using the Windows 2000 binaries to make sure you are using the correct set of 
binaries.

� Only certain types of upgrades are allowed (for example, changing a master server 
into a media server is not allowed). If the change is not allowed, uninstall the existing 
NetBackup software and then perform a new install as needed.

� All NetBackup servers must be at the same release level. VERITAS recommends that 
you upgrade in the following order:

a. Master Server

b. Media servers, if any 

c. NetBackup Remote Administration Console, if any

d. NetBackup clients 

e. Any NetBackup Add-on products (such as NetBackup for Oracle) 

� Make certain that the NetBackup release level on the server is at least equal to that on 
the clients. Older versions of server software can encounter problems with newer 
clients.

� Add-ons, with the exception of NetBackup Advanced Reporter, must be at the same 
level as the NetBackup client or Server on which they are installed.
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� You can upgrade to NetBackup 4.5 on systems that support a clustered configuration. 
For detailed information about clustered configurations and upgrading NetBackup 
on these systems, see Using NetBackup with Microsoft Cluster Server in the 
NetBackup System Administor’s Guide for Windows. 

Upgrading from NetBackup BusinesServer 4.5 to 
NetBackup DataCenter 4.5 

Upgrading from NetBackup BusinesServer to NetBackup DataCenter requires entering 
the appropriate license key.

� To upgrade BusinesServer to DataCenter

1. Locate your NetBackup DataCenter license key.

2. Open the NetBackup 
Administration Console 
window. On the Help menu, 
click License Keys. The 
NetBackup License Key 
window appears. 

3. Click on the New icon. 

4. Type your license key in the 
New license key field and 
click Add.

The new license key appears 
in the field in the lower part 
of the dialog box.

Note When upgrading from a BusinesServer evaluation license key to a permanent 
DataCenter base product license key on Windows, restart the NetBackup services. 
Restarting the services will ensure that the Help > About NetBackup menu displays 
the proper licensing information.

Note When making and saving any license key updates (including adding and deleting 
license keys) in the NetBackup Administration Console, you must restart the 
NetBackup Administration Console. 
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Configuring NetBackup Server Software
By default, the 
NetBackup 
Administration Console 
launches automatically 
following installation. 
However, you can 
configure your server at 
another time by starting 
the NetBackup 
Administration Console 
by selecting Start 
Programs > VERITAS 
NetBackup > NetBackup 
Administration Console. 

Note Before configuring NetBackup, make sure you have physically attached the storage 
devices to the server and performed all configuration steps specified by the device 
and operating system vendor (including installation of any required device drivers 
and software patches).

Once the server software and storage devices have been installed, select Getting Started 
on the NetBackup Administration Console to step through each process to configure your 
product. 

The look and feel of this interface is similar to Windows Explorer interface and contains a 
group of NetBackup configuration wizards in the right window pane that enable you to 
do the following: 

� Configure NetBackup using the Getting Started wizards

� Configure Storage Devices for NetBackup

� Configure Volumes

� Configure the Catalog Backup

� Create a Backup Policy 

Caution If you are configuring NetBackup for the first time, we recommend that you 
click on the Getting Started icon and using this set of wizards to guide you 
through the process. If you have already configured NetBackup and you wish 
to make a change to particular area, you can click on the any of the remaining 
options.
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Things to Know When Configuring Master and Media Servers
The process of configuring a master or media server is very similar. And the versatility of 
NetBackup enables you to install either server first. However, VERITAS recommends that 
you install and configure the master server before you install and configure a media 
server. You can then configure the media server information (such as storage devices and 
volumes) on the master to ensure the master server will properly administer the media 
server. The following list contains some help tips when configuring a media server.

� The NetBackup Administration Console appears after you install the media server. 
The name of the master server will appear as the Host server name in the left window 
pane of the NetBackup Administration Console if the master server was installed 
before the media server. 

� The name of the media server will appear as the Host server name in the left window 
pane of the NetBackup Administration Console if any of the following conditions 
exist:

- The master server has not been installed.

- The media server does not have permissions set on the master server.

- A network problem exists blocking the media server from communicating with 
the master server.

Caution If any of these situations exist, you will still be presented with the opportunity 
to run three of the configuration wizards (Storage Device, Volumes, and 
Configure a Shared Drive). Do not run these wizards. If you run these wizards, 
the information that you enter will not be recognized by the master server. 
VERITAS recommends that you correct the problem (such as installing the 
master server, correcting the permission settings, or solving the network 
problem) and run the configuration wizards from the master server.
Chapter 2, Installation and Initial Configuration 31



Configuring NetBackup Server Software
Begin Configuring NetBackup 
The following procedure guides you through a basic master server configuration process. 
As you can see from the figure below, the host name that appears in the NetBackup 
Administration Console is the name of the master server. 

1. To begin configuring your product, click on the Getting Started icon in the main 
window of the NetBackup Administration Console.The Getting Started - Welcome to 
NetBackup window appears. 

2. Click the Next button on the Welcome to NetBackup window. The Device Configuration 
window appears, and prompts you to begin the Storage Device configuration process.
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Configuring Storage Devices for NetBackup 

Before you can run any backups, you must define your storage devices for NetBackup. 
The following wizard will step you through this process.

Caution It is assumed that you have correctly configured your storage devices for 
Windows. NetBackup cannot function reliably unless devices are correctly 
installed and configured. 

1. From the Configure Storage 
Device window, click Next to 
start the Device 
Configuration wizard. The 
Welcome to the Device 
Configuration Wizard window 
appears. This wizard will 
step you through the process 
of: 

- Specifying device hosts

- Scanning those hosts for 
back-up devices

- Verifying the devices 
that were automatically 
detected

- Verifying and correcting the drive configuration

- Updating the drive configuration

- Configuring storage units

2. From the Device Hosts window, click the Add... button to specify the hosts on which 
to auto-discover and configure devices.

3. Click Next. The Scanning Hosts window appears and displays all devices that were 
discovered for a specific host.

4. Click Next. The Backup Devices window appears. 
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5. From the Backup Devices window confirm the list of devices displayed in this window. 
If the list is complete and accurate, click the Next button. If a known backup device 
does not appear in this list, do the following:

a. Click the Cancel button and close out of this wizard.

b. Verify that the backup device is physically attached to the host.

c. Verify all installation procedures specified by the device and operating system 
vendor have been performed successfully.

Note The VERITAS Tape Device Driver Install wizard (preloaded on your CD-ROM) will 
step you through the process of installing the latest device drivers. If you do not 
have a CD-ROM, you can download the NetBackup Tape Installer software from 
the VERITAS support web site. 

d. Return to the NetBackup Administration Console and click the Configure 
Storage Devices link. Perform Steps 1 through 6 again.

e. Click Next. The Drag and Drop Configuration window appears.

6. Verify that all drives are in their proper location. If you need to move a drive, simply 
select the drive and drag it to the location. 

7. Click Next. NetBackup begins updating the device configurations and the Updating 
Device Configuration window appears. This update may take a few minutes to 
complete.

8. Click Next after the device configuration update completes. The Configure Storage 
Units window appears. Use this window to define storage units. If your system does 
not have a storage device, you can store data on a disk by defining disk storage units. 

When entering a path for a storage unit, the following rules apply:

- Use the correct path separators (/ and \).

- Use a colon (:) to specify a drive separation on Windows platforms.

- Use the following characters only: 

- Alphabetic characters (ASCII A-X, a-z)

- Numeric characters (0-9)

- Miscellaneous characters: Plus (+), minus (-), underscore (_), or period (.)

9. Click Next. The Finished window appears. 

10. Click Finish. The Getting Started- Volume Configuration window appears.
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Configuring Volumes 

After you have configured your storage devices, the Getting Started wizard leads you into 
the Volume Configuration wizard. In this process, you initiate an inventory process of 
each configured robot. NetBackup automatically updates the volume database if it finds 
new robotic media during the inventory. You will also define new volumes for use in 
standalone drives. For more detailed information about volumes or configuring volumes 
for standalone drives, refer the to Media Manager System Administrator’s Guide.

1. From the Volume Configuration window, click Next. The Welcome to the Volume 
Configuration wizard appears. 

This wizard will step you 
through the process of:

- Selecting a device for 
volume configuration

- Performing an inventory 
of the robot

- Creating new volumes

- Creating new volume 
groups

2. Click Next. The Select Device 
window appears. 
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3. Select a robot that you want to inventory or the type of standalone drive for which 
you want to configure volumes. If you are configuring volumes for a robot proceed to 
Step 5. (Steps a. through d. describe the wizard if you select a standalone drive.)

a. If you choose a 
standalone drive and 
click Next. The 
Standalone Media 
window appears. From 
this window you can 
decide on the number of 
volumes for your device. 

b. Select the number of 
volumes from the 
drop-down menu.

c. Click Next. This 
conclude the Volume 
Configuration wizard. 

d. Click Finish. The Getting Started - Catalog Backup Wizard window appears.

4. Click Next. The Specify if Multiple Drive Types Exist window appears.

From this window, you must specify if multiple drives exist. A robot is considered to 
have more than one type of drive if the media written in any one drive cannot be read 
or written in any other drive. 

If the robot has more than one type of drive, then the wizard cannot inventory the 
robot.

5. Select either the Yes or No option on this window, to determine if the robot has at least 
one of the drive on a different device host that is not of the same type.

6. Click Next. The Robot Inventory window appears. 

At this time the NetBackup software is conducting an inventory of the Robot that you 
previously selected. This window enables you to view the results of this inventory 
once the inventory completes. You can view these results in the Results: field.
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7. Click Next. The Identify 
Cleaning Media window 
appears. 

After the inventory process 
of your device completes, 
the software prompts you to 
identify which slots within 
your device contain cleaning 
media. 

If you have just upgraded 
NetBackup and have 
pre-existing bar-code rules, 
then the bar-code reader will 
automatically detect slots 
designated for cleaning 
media. Otherwise, if you do not designate a cleaning slot(s), then NetBackup will 
consider all media (including cleaning media) as typical media and try to overwrite it.

8. Click Next. If you identified one or more tapes as cleaning tapes on the Identify 
Cleaning Media window, then the Robot Inventory (Cleaning Media) window will appear. 

This window displays the results of NetBackup after the software updates the media 
manager volume configuration. 

9. Click Next. This concludes the Volume Configuration wizard.

Note This wizard does not enable you to configure cleaning tapes for standalone drives.

10. Click Finish. The Getting Started - Catalog Backup Wizard window appears. You are 
now ready to configure the catalog backups for your system.
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Configure the Catalog Backup 

After you have configured your storage devices and volumes, the wizard leads you into 
configuration of the catalog backup. The NetBackup Catalog contains information about 
your configuration and about the files and folders that have been backed up. In case a disk 
fails and your catalog is lost, a backup of your catalog makes it much easier to restore your 
backed-up data and resume your backup schedule. Therefore, it is imperative that you 
configure a catalog backup before backing up any other data. 

1. From the Configure the Catalog Backup window, click Next. The Catalog Backup wizard 
begins. With this wizard you will: 

- Specify the media server 
that will perform the 
backup. 

- Specify the location of 
the NetBackup Catalog.

- Specify one or two 
destinations for the 
catalog backup. A 
backup destination can 
be either removable 
media or a location on a 
hard drive. 

- Specify when a backup 
of the NetBackup 
Catalog will occur.

2. To begin, you must first select a media server. If you want to back up the catalog to 
removable media, select the media server that has the drive or drives you want to use 
to write the backup to the media. If you want to back up the catalog to a hard drive 
(not recommended), specify the computer that contains the hard drive.

3. Click Next. The NetBackup Catalog Files window appears.

4. From the NetBackup Catalog Files window, verify that the master server’s and each 
media server’s catalogs are included in the list. Verify that the absolute pathnames are 
correct and are in the correct format. 

The pathnames of the catalogs on the master server are automatically added during 
installation and generally require no action on your part other than to ensure they are 
listed. However, if you have moved the location of your catalog on your master 
server, the new location must be specified. Pathnames to the NetBackup Catalog on 
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the media servers are not automatically added during installation and require that 
you add them to the file list. For more information on specifying the pathnames, see 
NetBackup DataCenter System Administrator’s Guide for Windows.

Caution Make sure there are no invalid paths in the list of catalog files to be backed up, 
especially after moving catalog files, deleting old paths, or adding new paths to 
the catalog backup configuration as explained in this chapter. If NetBackup 
cannot find or follow a path, the entire catalog backup fails.

5. Click Next. The Media Type 
for the Destination window 
appears.  

6. From the Media Type for the 
Destination window choose a 
media type and click Next.

The Removable media 
option forces you to 
manually swap the 
scheduled backup tape with 
the catalog backup tape each 
time a scheduled backup is 
complete. The Disk option 
avoids this situation.

a. .If you have configured a 
robot and/or a 
standalone drive and if 
you chose to back up the 
catalog to a tape, the 
Destination Volume 
window appears. Select 
the volume (for example, 
a removable media such 
as a tape) that you want 
to use for the backup on 
the Destination Volume 
window
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b. If you do not have any 
robots or standalone 
drives configured, or if 
you selected to back up 
the catalog to a hard 
drive on the Media Type 
for the Destination page, 
the Folder for the 
Destination window 
appears. Enter the 
directory that you want 
NetBackup to use to 
save catalog backups in 
the text field on the 
page.

7. Click Next. The Alternating Destinations window appears.

8. The Alternating Destinations window enables you to specify a second location for 
backing up the Catalog. 

❖ If you do not want to create an alternate destination:

a. Uncheck the Alternate destinations when backing up the catalog check box 

b. Click Next. The When to Back Up the Catalog window appears, proceed to the next 
step.

❖ To create an alternate destination:

a. Verify that the Alternate destinations when backing up the catalog check box is 
selected. 

b. Click Next. The Media Type for the Alternate Destination window appears.

c. The next sequence of windows that appear are similar to the steps you just 
performed.

d. After you have finished adding an alternate destination, click Next. The When to 
Back Up the Catalog window appears.
40 NetBackup DataCenter Installation Guide for Windows



Configuring NetBackup Server Software
9. From the When to Back Up the 
Catalog window, select when 
you want to back up the 
NetBackup Catalog from the 
list of options. If you need 
help making a selection, 
click the More Info… 
button. 

10. Click Next.

11. Click Finish. This completes 
the NetBackup Catalog 
configuration wizard and 
the Policy Configuration 
window appears.

Create a Backup Policy 

After you have configured your catalog backup, the wizard leads you into configuration 
of backup policies. In this step you define a backup policy for a group of one or more 
clients. This means specifying when the backups will take place, the files you want to back 
up, the clients you want to back up, and other general attributes that define how the 
backup is performed. 

1. From the Policy Configuration window, click Next. The Welcome to the Backup Policy 
Configuration wizard appears. 

2. Click Next to start the 
Backup Policy Configuration 
wizard. The Policy Name and 
Type window appears.

This wizard will step you 
through the process of 
specifying:

- Policy names and types

- Clients

- Files and folders to back 
up

- Backup rotations

- Starting times of 
backups
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3. From the Policy Name and Type window:

a. Enter a name in the Policy Name field.

b. Select a Policy type from the Policy Type drop-down box.

c. Click Next. The Client List window appears.

4. Add, Change, or Delete 
clients to this policy. 
NetBackup will back up all 
clients added to this list. To 
add a client perform the 
following:

a. Click Add. A text field 
appears that contains a 
browse icon.

b. Enter the computer 
name in the text field or 
click the Browse for 
Computer icon and 
search for the computer.

c. Repeat Steps a and b to add more computer clients to the list.

d. Click Next. The Files window appears. 
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5. From the Files window you will identify which files and folders you want to back up. 
You can elect to back up all local drives by clicking the Back up all local drives check 
box. You can also administer the list of folders and files from this window by inserting 
new entries in the list, making changes, or deleting entries from the list. 

a. Click Add. A text field 
appears that contains a 
Remote Folder icon and 
a Select Directive icon.

b. Enter the path of the 
folder or file that you 
want to back up in the 
text field or click the 
Browse Folder icon to 
search for the folder or 
file.

c. Click the Select 
Directives icon. The 
Select Directive window 
appears and enables you to associate various directives to specific folders and 
files.

d. Press Enter on your keyboard or click outside the edit box in the Files window.

e. Repeat Steps a through d to add more folders and files to the list.

f. Click Next. The Backup Type window appears. 

6. Select the type of back up that you want this policy to perform. 

- Full Backup. Backs up all files specified in the file list.

- Incremental Backup. Backs up all changed files specified in the file list.

- Cumulative

- Differential

- User Backup. Enables the user to initiate a backup or archive on their own.

7. Click Next. The Rotation window appears.

8. Select how often you want this backup policy to run for a full or incremental backup. 
In addition, you can select the retention period for the backups. 
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9. Click Next. The Start Window interface appears. 

10. The Start Window enables 
you to specify the window in 
which backups can start. 
From this window you can:

- Select a range of hours 
(Off hours, Working hours, 
All day) to enable a 
backup to start.

- Select Custom and 
adjust a the time slot for 
each day by selecting a 
day of the week, a start 
time, and a duration 
time. 

11. Click Next. This completes the creation and configuration of a policy. To make 
changes to this policy or create another policy, open the NetBackup Administration 
Console and click the Create a Backup Policy wizard.

12. Click Finish. The Policy Configuration window appears again. This window enables 
you to create another NetBackup Policy. 

a. If you do not want to create another policy, click Next. The NetBackup Installation 
Test window appears. 

b. If you want to create another policy, check the Create another NetBackup Policy 
(class) check box and click Next. You will repeat the same procedure that you just 
completed. 
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Testing NetBackup Installation 

After you have finished configuring NetBackup, you have the opportunity to test your 
NetBackup configuration by initiating an immediate backup based on the installation 
process you just completed. 

1. Click the Start an immediate backup of NetBackup server to verify the installation 
check box.

2. Click Next. The Getting Started - Setup is Complete window appears. You have 
completed a basic installation and configuration of NetBackup DataCenter.

After you click the Finish button, NetBackup will begin the backup process according 
to your installation configuration. You can monitor the status of this backup by 
opening the NetBackup Administration Console and double-clicking the Activity 
Monitor icon in the left window pane.

You can then right mouse click on the picture of the server in the Topology window 
pane and select Job Details. The Job Details window appears and provides a status of 
the current job.
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NetBackup Client Software 
By definition, your NetBackup server is also a NetBackup client. When you installed the 
NetBackup server software, both the NetBackup server and NetBackup client software 
were installed on the server. 

Client Installation Requirements 
To install NetBackup client software on a PC workstation, the workstation must meet the 
following configuration requirements. 

Microsoft Windows Clients

� Microsoft Windows (95, 98, ME, NT, 2000, XP (32 and 64 bit), and LE)

- Windows NT 4.0 (service pack 6A) or Windows 2000 (service pack 2) installed. 

- Windows 95 users must have the Windows Socket 2 Update for Windows 95. This 
download can be found at:

www.microsoft.com/windows95/downloads/contents

� An Intel Pentium processor

� Internet Explorer 5.5 or greater 

� Any TCP/IP transport that is Windows Sockets Compliant. (Use of the TCP/IP 
transport that comes with the server or operating system is recommended.)

� A network adapter supported by your TCP/IP transport.

Remote Installation Requirements

To perform remote installations, there are several additional requirements:

� The source PC must have Windows NT or Windows 2000 installed.

� The destination PC must have Windows NT or Windows 2000 installed. 

� The person performing the remote installation must have administrator privileges on 
all the client PCs.

Note The rsh mechanism for defining a trusted remote host does not work with SuSE 
Linux 7.2. VERITAS recommends that you use the ftp method of pushing the 
NetBackup client remotely instead of the rsh trusted host method for this platform.
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Installing NetBackup Client Software
The following are quick-start instructions for installing NetBackup client software. For 
further information on installing and configuring software on PC clients, see the 
NetBackup Installation Guide - PC Clients.

Note The 64-bit client installs are located in \pc_clnt\ia64 folder, and is inaccessible 
from the launch screen.

The debug symbols are not on the CD-ROM and are not install if selected.

You will not have the ability to choose to not install the documentation.

Install NetBackup Client Software Locally

You can stop the installation process at any time by clicking Cancel or return to a 
previous window by clicking Back.

1. If the system is Windows 95, 98, or ME, and NetBackup is currently installed, stop the 
NetBackup Client Service before continuing the installation. 

Windows NT and Windows 2000 computers stop the service automatically.

2. Insert the NetBackup CD-ROM in the drive.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS 
NetBackup installation browser starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

The VERTIAS NetBackup installation browser appears. 
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3. Click the NetBackup Installation link. The browser refreshes and displays 
pre-installation information and NetBackup Installation links.

4. Click Start NetBackup Client Intallation. The Welcome to the NetBackup Setup Wizard 
window appears.

5. Click Next. The NetBackup Installation Type window appears.

6. Select the Install to this computer only, option to install the client software locally. 

Note You cannot do a remote install to or from these systems: Windows 95, 98, ME, or the 
64-bit versions of XP and LE.

7. Click Next and continue the installation process. The Setup Type window appears.

This window enables you to chose to perform a typical or custom installation. This 
procedure demonstrates the ease of a typical installation. To view the differences 
between a typical installation and a custom installation refer to “Custom Installation 
Differences for Client Software” on page 54.
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8. Select the Typical option and 
click Next. The NetBackup 
System Names window 
appears. From this window 
you will enter the names of 
the systems that will have 
access to this local system.

9. Click Next. The Ready to 
Install the Program window 
appears. 

10. Click the Install button. The 
installation process for the 
NetBackup Client Software 
begins. 

11. The Setup Complete window is displayed. Click Finish.

Note You may need to reboot your PC for the changes to take effect.

Install NetBackup Software Remotely

Follow these instructions to install the NetBackup client software on selected 
Windows NT and 2000 clients on your network (one of these clients can be your local PC). 
You may stop the installation process at any time by clicking Cancel.

Remote Installation Requirements 

To perform remote installations, there are several additional requirements:

� The source PC must have Windows NT or Windows 2000 installed.

� The destination PC must have Windows NT or Windows 2000 installed. 

� The person performing the remote installation must have administrator privileges on 
all the client PCs.

� During remote installation, the client name is written to the registry in lower case. If 
the policies on the NetBackup server do not specify the client names in lower case, 
backups will fail because the names do not match.
Chapter 2, Installation and Initial Configuration 49



NetBackup Client Software
To install NetBackup client software remotely

Note Clicking the Cancel button during a remote install process will not cancel the install 
on the remote system that is in progress at the time cancel is clicked. The installation 
will continue until it is finished. Any remote installs that remain will not be 
performed, and any remote installs that were successful to that point will continue 
to be successful.

1. Insert the NetBackup CD-ROM in the drive.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS 
NetBackup Installation browser starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

The VERTIAS NetBackup installation browser appears. 

2. Click the NetBackup Installation link. The browser refreshes and displays 
pre-installation information and NetBackup Installation links.

3. Click Start NetBackup Client Intallation. The NetBackup Client Installation wizard 
window appears.
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4. Click Next. The NetBackup Installation Type window appears.

5. Select the Select from available computers on the network, option to install the client 
software remotely. (The Setup software will scan the network for available clients.)

6. Click Next and continue the installation process. The Setup Type window appears.

This window enables you to chose to perform a typical or custom installation. This 
procedure demonstrates the ease of a typical installation. To view the differences 
between a typical installation and a customer installation refer to “Custom 
Installation Differences for Client Software” on page 54.

7. Select the Typical option and 
click Next. The NetBackup 
System Names window 
appears. From this window 
you will enter the names of 
the systems that will have 
access to this local system. 
You must enter a master 
server name in the window.

8. Click Next. The Install 
NetBackup Client to remote 
systems window appears. 

From this window you will 
select the NetBackup Client 
destination systems from the 
list of available systems.
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9. Select a system from the 
Available Systems window 
and click the right-arrow 
button to move this system to 
the Destination Systems 
window.

Note Multiple systems can be 
added by using the CRTL 
or shift keys when selecting 
them with your mouse.

10. Repeat Step 9 until you have 
identified all destination 
systems.

In some instances, an Enter Network Password dialog window will appear when you 
select a system from the Available Systems window.

a. Provide the user name, password and domain of an administrator on the remote 
system.

b. Select the Remember User Name and Password box to apply the same user name 
and password to all of the systems yet to be selected.

c. Click OK. This system will then be added to the Destination Systems window.

11. Click Next. The Ready to Install the Program window appears.

12. Click the Install button. The installation process for the NetBackup Client Software 
begins. 

13. The Setup Complete window is displayed. Click Finish.

Note You may need to reboot your PC or the remote systems for the changes to take 
effect.
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Installing NetBackup client software silently

Note Silent installations of NetBackup Client software are not supported if you want to 
run the NetBackup services as a user rather than the local system. If you want to 
install NetBackup under this circumstance you must go through the interactive 
installation described earlier in this document.

1. If you are running Windows, start the Windows Installer from the following locations:

- Windows NT Systems using an Intel Pentium processor:

PC_Clnt\Win32\X86\instmsiw.exe

- Windows 95 and 98 systems using an Intel Pentium processor:

PC_Clnt\Win32\X86\instmsia.exe

Note Do not run instmsiw.exe or instmsia.exe on Windows ME and Windows 
2000 systems.

2. Copy the contents of PC_Clnt\Win32\Common to a temporary directory on your 
hard drive. 

3. In the temporary directory, use a text editor to edit silentclient.cmd (on 
Windows NT, 2000, XP, and LE systems) and silentclient.bat (on Windows 95, 
98, and ME systems) so the script will install the client software as you wish.

4. Run the script.

5. Check the NetBackup Install.log log file to verify that the install was 
successful. On Windows 2000 systems, the location may be different.

Note After the installation completes successfully, a NetBackup installation log file is 
generated. You can find this log file at the default temp directory. To determine 
where your TEMP directory is located, refer to “Locating the NetBackup Installation 
log file for Windows 2000 systems” on page 21 or “Locating the NetBackup 
Installation log file for Windows NT systems” on page 21.

Note You may need to reboot the computer for the changes to take effect.
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Custom Installation Differences for Client Software 
During the installation of NetBackup Client software you can chose between performing a 
typical or a custom installation. The typical installation uses predefined values and 
parameters when performing the installation. The custom installation enables the user to 
make modifications to specific parameters. This section briefly explains the changes that 
can be made. 

A customer installation begins the same as a standard installation, therefore all steps prior 
the Setup Type window are identical. This procedure begins after you have clicked on the 
Custom link on the Setup Type window.

1. Select the Custom radio 
button and click Next. The 
Custom Setup window 
appears. From this window 
you can elect to change the 
location of the installation 
for the following products:

- NetBackup

- User Documentation

- Open Transaction 
Manager

From this window you 
can chose which product 
feature, and in some 
cases subfeatures, to install. In the figure above, all items are selected to be 
installed. To mark a feature as unavailable do the following: 
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a. Select the icon next to 
the feature that you 
want to change.A 
pop-up window 
appears. 

b. Click This feature will 
not be available. A red 
“X” appears in the icon 
signifying the feature 
will not be installed.

Note You cannot change the 
install location when 
performing a silent 
installation.

2. Click Next. The NetBackup 
Services window appears. 

From this window, you:

- Enter a user name and 
password or elect to the 
built-in system account 
information that already 
exists.

Note This step is not available 
during a silent installation.
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3. Click Next. The NetBackup 
Options window appears.

From this window enables 
you to customize your 
NetBackup client.

- Select if you would like 
the client services to start 
automatically at system 
start-up.

- Decide whether to stat 
NetBackup Client 
Service after install.

- Modify ports should 
there be a conflict.

4. Click Next. The NetBackup 
System Names window 
appears. From this window 
you will enter the names of 
the systems that will have 
access to this local system. 
You must enter a master 
server name in this window.

5. Click Next. The Ready to 
Install the Program window 
appears. 

6. Click Install. The installation 
process for the NetBackup 
Client Software begins. 

7. The Setup Complete window is displayed. Click Finish.

Note If this is an upgrade procedure, you must need to reboot your computer for the 
changes to take effect.

If you want to make changes to the installation settings, click the Back button until 
you reach the page where you can make the change, or click the Cancel button and 
exit the wizard.
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Other Client Software Installations 

Netware Target and Nontarget 

For detailed instructions on how to install Netware Target and Nontarget clients, refer to 
the NetBackup Installation Guide - PC Clients.

Macintosh 

For Macintosh installation instructions, refer to the NetBackup Installation Guide - PC 
Clients. 

Note You can install Macintosh clients from the NetBackup 4.5 CDROM.

UNIX 

1. Insert the NetBackup CD-ROM into the drive on the client computer.

HP systems only: Because the NetBackup CD-ROM is Rockridge formatted, it must be 
mounted by entering the following commands:

nohup pfs_mountd &
nohup pfsd &
pfs_mount -o xlat=unix /dev/dsk/device-ID /cdrom

Where device_ID is the ID of your CD-ROM drive.

2. Change your working directory to the CD-ROM directory:

cd cd_rom_directory

Where cd_rom_directory is the path to the directory where you can access the 
CD-ROM. On some platforms, it may be necessary to mount the directory.

3. Start the install program.

./install

4. Choose option 2, NetBackup Client Software.

Note The choices provided for OS level represent the OS Level on which the binaries 
were compiled. Often the binaries will function perfectly on newer versions of the 
operating system. For example, Solaris 2.6 binaries also are used on Solaris 7 and 
Solaris 8 levels of the operating system. So, if you wish to install on a Solaris 8 
system, choose the Solaris 2.6 binaries.
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5. Follow the prompts to complete the installation.

6. On HP systems only—to unmount the CD-ROM:

- Execute the pfs_umount command

- Use the kill command to kill the following processes:

pfs_mountd
pfsd
pfs_mountd.rpc
pfsd.rpc
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Installing Alternative Administration Interfaces 
You can install a NetBackup user interface on a different computer. (This will be necessary 
if your server computer has no graphics display capabilities.) 

NetBackup Remote Administration Console for Windows
You can skip this section if you do not want to remotely administer a NetBackup server 
from a Windows NetBackup client.

The NetBackup Remote Administration Console for Windows servers is a version of 
NetBackup for Windows that can be used to remotely administer one or more UNIX or 
Windows NetBackup servers. It provides all of the standard NetBackup Server for 
Windows interfaces and can be used to create backup policies, manage volumes, view 
status, monitor tape drives, etc., on a remote NetBackup server. It cannot be used as a 
NetBackup master or media server itself—only for the remote administration of other 4.5 
NetBackup UNIX or Windows servers.

Note The Windows NetBackup servers that support the NetBackup Remote 
Administration Console are Windows NT and Windows 2000. For information 
about the supported platforms for the NetBackup 4.5 release, refer to the Supported 
Platforms and Peripherals chapter in NetBackup Release Notes for UNIX and Windows.

Although the NetBackup Remote Administration Console cannot be used as a master or 
media server, in order for it to remotely administer a NetBackup server, it must be added 
to the server list on that server in the same way that other NetBackup servers are added to 
the server list to give them access to that server.

The NetBackup manuals and on-line help do not, in most cases, specifically refer to the 
NetBackup Remote Administration Console since, for all practical purposes, using the 
NetBackup Server for Windows interfaces on the NetBackup Remote Administration 
Console is identical to using them locally on the server that is being administered. Of 
course, the master server or device host shown in the interface will be the server name 
that is being administered instead of the local server name.

System Install this user interface

Windows NetBackup Remote Administration Console

UNIX UNIX (NetBackup-Java capable) client
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� The following steps describe how to install the remote server:

1. Go to the computer on which you want to install the NetBackup Remote 
Administration Console and insert the CD-ROM that contains the NetBackup server 
software.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS 
NetBackup installation browser starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

2. On the NetBackup - Install screen, click the Install option beneath NetBackup Server.

3. Click Next.

4. Select NetBackup Remote Administration Console.

5. Follow the prompts to complete the installation.

Note On the NetBackup System Names screen, the name of the NetBackup Remote 
Administration Console should be in the first entry field. You must enter the name 
of the remote NetBackup DataCenter computer in the Master Server field.

When the software is installed, a set of NetBackup documents are also installed in the 
following directory:

install_path\Help

By default, install_path is C:\Program Files\VERITAS.

By default, the NetBackup Remote Administration Console will automatically begin 
as soon as you click Finish in the installation program. (If you did not choose that 
default, go to the Windows Start menu on the NetBackup Remote Administration 
Console computer and select Start > Programs > VERITAS NetBackup > NetBackup 
Administration > Console.)

� The following steps will add the NetBackup Remote Administration Console host to 
the server list of the remote DataCenter server.

Note On a UNIX system, there are two procedures that you can use to add the host to the 
server list; you can use the NetBackup-Java GUI (if your system is NetBackup-Java 
Console compatible) or you can edit the bp.conf file. Step 1 describes this process 
using the NetBackup-Java GUI and Step 2 describes how to add the edit the 
bp.conf file.
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1. Use the NetBackup-Java GUI to specify and add the remote UNIX DataCenter to the 
server list. (If you perform this step you can proceed to step 3.)

a. In the left pane of the NetBackup-Java GUI, select Host Properties > Master 
Servers. The host server appears in the main window.

b. Right click on the name of the host server in the Master servers window in the 
right pane. 

c. Select Properties. The Master Server Properties window appears.

d. In the Master Server Properties window, select the Servers icon from the tree in the 
left window pane.

e. In the Servers window, click the New button. 

f. Type the name of the host that is to run the NetBackup Remote Administration 
Console. 

g. Then click the OK button. The name of the host appears in the Additional Servers 
list.

h. Click OK.

2. Edit the bp.conf file to add the remote UNIX DataCenter to the server list.

a. Go to the remote NetBackup UNIX server. 
In the /usr/openv/netbackup/bp.conf file, at the end of the SERVER = 
lines, add the following line:

SERVER = name-of-Administration-Console-machine

Where name-of-Administration-Console-machine is the name of the machine where 
the NetBackup Remote Administration Console will be installed.

3. If you have an existing NetBackup Remote Administration Console installed and you 
want to add a remote master server, perform the following steps.

a. Go to the remote NetBackup Windows Server and start the NetBackup 
Administration Console. 

b. In the left pane of the NetBackup Remote Administration Console, select Host 
Properties > Master Server. The host server appears in the main window.

c. Right click on the name of the host server in the Configuration for servers of (host 
server name) window. 
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d. Select Properties (Read/Write). The Master Server Properties window appears.

e. In the Master Server Properties window, click the Servers tab.

f. In the Global Operations box, in the field labeled Add to all lists, type the name 
of the host that is to run the NetBackup Remote Administration Console. Then 
click the “+” button. (The name of the host appears in the Additional Servers list.)

g. Click OK.

NetBackup Remote Administration Console for UNIX 
You can skip this section if you do not want to remotely administer a NetBackup server 
from a UNIX NetBackup client.

The NetBackup Remote Administration Console for UNIX can be used to remotely 
administer one or more UNIX or Windows NetBackup servers. It provides all of the 
standard NetBackup Server for Windows interfaces and can be used to create backup 
policies, manage volumes, view status, monitor tape drives, etc., on a remote NetBackup 
server. It cannot be used as a NetBackup server—only for the remote administration of 
other 4.5 NetBackup UNIX or Windows servers.

Note Remote administration of Windows servers using the NetBackup Remote 
Administration Console for UNIX is done via the “change server” functionality in 
the console. You cannot specify the Windows server host in the console login dialog 
to administer it directly. The UNIX server host specified in the login dialog must be 
in the server list of all NetBackup servers that you want to administer via the 
“change server” capability in the console. For more detail, refer to the NetBackup 
System Administrator’s Guide for UNIX.

To use the NetBackup Remote Administration Console to remotely administer a 
NetBackup server, it must be added to the server list on that server in the same way that 
other NetBackup servers are added to the server list to give them access to that server.

� The following steps describe how to install a remote server:

1. Go to the computer on which you want to install the NetBackup Remote 
Administration Console.

2. Insert the NetBackup CD-ROM into the drive on the client computer and following 
the procedure for locally installing software. Refer to “Install NetBackup Client 
Software Locally” on page 47.
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� The following steps will add the NetBackup Remote Administration Console host to 
the server list of the remote DataCenter server.

Note On a UNIX system, there are two procedures that you can use to add the host to the 
server list; you can use the NetBackup-Java GUI (if your system is NetBackup-Java 
Console compatible) or you can edit the bp.conf file. Step 1 describes this process 
using the NetBackup-Java GUI and Step 2 describes how to edit the bp.conf file.

1. Use the NetBackup-Java GUI to specify and add the remote UNIX DataCenter to the 
server list. (If you perform this step you can proceed to step 3.)

a. In the left pane of the NetBackup-Java GUI, select Host Properties > Master 
Servers. The host server appears in the main window.

b. Right click on the name of the host server in the Master servers window in the 
right pane. 

c. Select Properties. The Master Server Properties window appears.

d. In the Master Server Properties window, select the Servers icon from the tree in the 
left window pane.

e. In the Servers window, click the New button. 

f. Type the name of the host that is to run the NetBackup Remote Administration 
Console. 

g. Then click the OK button. The name of the host appears in the Additional Servers 
list.

h. Click OK.

2. Edit the bp.conf file to add the remote UNIX DataCenter to the server list.

a. Go to the remote NetBackup UNIX server. 
In the /usr/openv/netbackup/bp.conf file, at the end of the SERVER = 
lines, add the following line:

SERVER = name-of-Administration-Console-machine

Where name-of-Administration-Console-machine is the name of the machine where 
the Administration Console will be installed.
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3. If you have an existing NetBackup Remote Administration Console installed and you 
want to add a remote master server, perform the following steps.

a. Go to the Remote NetBackup Windows server and open the NetBackup Remote 
Administration Console.

Note If this is a clean installation, you can add the masters that you want to administer as 
additional servers during the install.

b. In the left pane of the NetBackup Remote Administration Console, select Host 
Properties > Master Server. The host server appears in the main window.

c. Right click on the name of the host server in the Configuration for servers of 
(host server name) field. 

d. Select Properties (Read/Write). The Master Server Properties window appears.

e. In the Master Server Properties window, click the Servers tab.

f. In the Global Operations box, in the field labeled Add to all lists, type the name 
of the host that is to run the NetBackup Remote Administration Console. Then 
click the “+” button. 

The name of the host appears in the Additional Servers list.

g. Click OK.
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Installing NetBackup Java Windows Display Console 
The NetBackup Java Windows Display Console enables you to run the NetBackup Java 
(UNIX) interfaces on any supported Windows server platforms. This interface enables 
you to backup, archive, and restore data remotely. 

You can skip this section if you do not want to remotely administer your UNIX 
NetBackup servers using the NetBackup Java Windows Display Console on a Windows 
server.

Note You can install the NetBackup Java Windows Display Console from the NetBackup 
CD-ROM.

Requirements
For the computer on which you want to run the NetBackup Java Windows Display 
Console, VERITAS recommends 256 MB of physical memory.

� To install the NetBackup Java Windows Display Console:

1. On the system where you are performing the install, insert the CD-ROM that contains 
the NetBackup server software.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the NetBackup 
install program starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

2. On the NetBackup Install browser, click the Additional Products link in the left 
column on browser. The main window updates and enables you to install additional 
products or view documentation.

3. Click the Additional Products Installation link. The browser refreshes and displays 
the current list of products available for installation.

4. Click on the NetBackup Java Windows Display Console link. A welcome dialog box 
appears. 

5. Continue the installation by following the prompts to install the NetBackup Java 
Windows Display Console.
Chapter 2, Installation and Initial Configuration 65



Installing NetBackup Agents and Options
6. When the software is installed, see the following document for information on using 
the display console (this document is installed with the software):

install_path\Java\Readme.txt

Where, by default, install_path is C:\Program Files\VERITAS.

Installing NetBackup Agents and Options 
After your initial installation is complete, you can install any other NetBackup agents and 
options (such as NetBackup for Oracle) by following the instructions in the NetBackup 
guide that comes with that product.
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3

This chapter gives instructions for uninstalling and reinstalling NetBackup software.

Uninstalling NetBackup Server Software

Caution This procedure removes the NetBackup catalogs. If you intend to do a reinstall, 
be certain to save the configuration, catalog, and log file information before 
proceeding (see “Uninstall NetBackup server software and save catalog data for 
Windows 2000 users” on page 68).

Note If you are uninstalling NetBackup from a machine that has NetBackup-Java Display 
Console loaded, the Console will be removed. You will need to install the Console to 
continue using it on the machine.

� Uninstall NetBackup server software

Note It is always good practice to backup your NetBackup catalogs before uninstalling.

1. From the Start menu, click Settings, then Control Panel. The Control Panel window 
appears.

2. From the Control Panel window, double click the Add/Remove Programs icon. The 
Add/Remove Programs window appears.

3. Select VERITAS NetBackup from the Currently Installed Programs list. 

4. Click the Remove button.
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� Uninstall NetBackup server software and save catalog data for Windows 2000 users

Note For Windows 2000 users. clicking the Remove button during a product uninstall 
will, by default, remove all NetBackup configuration and catalog information. The 
following procedure explains the necessary steps to retain this information for 
future reinstalls.

1. From the Start menu, click Settings, then Control Panel. The Control Panel window 
appears.

2. From the Control Panel window, double click the Add/Remove Programs icon. The 
Add/Remove Programs window appears.

3. Select VERITAS NetBackup from the Currently Installed Programs list. 

4. Click the Change button. This action enables you to modify, repair, or remove 
NetBackup.

5. Select Remove on the Program Maintenance Dialog.

6. Click in the Remove all NetBackup Congifuration, Catalog, and Log files check 
box to disable this function. (This check box contains a check mark by default.)

7. Click the Remove button.

Reinstalling NetBackup Server Software 
This procedure describes how to install NetBackup after you have uninstalled the 
product, but saved your configuration, catalog, and log files. 

� Reinstall NetBackup server software with saved configuration and catalog 
information

1. When reinstalling a NetBackup product, you should have your license key(s) 
available throughout the installation process.

Caution You must reinstall this product in the exact location as the previous installation 
to ensure your saved configuration, catalog, and log files will function properly 
with the new product.

2.  Log in as Administrator on the server where you will be installing NetBackup.
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3. Insert the NetBackup CD-ROM in the drive.

- On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS 
NetBackup installation browser starts automatically.

- On Windows systems that have AutoPlay disabled, run Launch.exe in the 
top-level directory on the CD-ROM.

4. On the NetBackup - CD browser, click on the NetBackup Installation option in the 
main window. The contents of the main browser window will display the following 
information and options:

- Links on the left side of the browser that display information pertaining to 
NetBackup, Database Agents, and Additional Products.

- Browse the CD

- The NetBackup link selected (by default) and these available options:

- Begin NetBackup Installation

- View Certification Information

- View available documentation

- Link to VERITAS Technical Support

- Link to VERITAS e-Learning
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5. Click NetBackup Installation.The browser refreshes and displays pre-installation 
information.

6. Click the appropriate link of the installation (client or server) that you want to start. 
The NetBackup Setup wizard begins.

7. Click Next. The NetBackup License Key and Server Type window appears. 
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8. Enter the base product license key that you received when you purchased your 
product. The license key that you enter will determine which of the three installations 
are available for you to install. 

9. Select the type of installation that you want to perform. 

Note Installing NetBackup Remote Administration Console does not require a license 
key.

10. Click Next. The Setup Type window appears. You can elect to perform a typical or a 
custom installation. Refer to “Custom Installation Differences” to see the differences 
in the installation processes. 

11. Select Typical and then click Next. The NetBackup System Names window appears. 

From this window you can enter the names of the systems that will have access to this 
current system.

Note If installing a media server, the NetBackup System Names window will have an 
additional line with the local media server filled in. You must enter a Master Server 
name that this media server is configured to.

12. Enter the server names and click Next. The NetBackup Global Device Database Host 
window appears. 

13. Enter the name of the 
NetBackup Global Device 
Database Host, which serves 
as the repository for global 
device configuration 
information. For more 
information about the Global 
Device Database Host, see 
NetBackup dataCenter Media 
Manager System 
Administrator’s Guide for 
Windows.
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Under most circumstances, this can be left as the default, which is the master server. 
However, you may need to enter a different host name in the following situations:

- If the system shares drives with the Shared Storage Option (SSO), all NetBackup 
servers must use the same host for storing device information.

- If the system has multiple master servers, enter the name of the server that will 
store the global device configuration information. Conflicting host information 
may result in an error. 

Note If you want to make changes to the installation settings, click the Back button until 
you reach the page where you can make the change, or click the Cancel button and 
exit the wizard.

14. Click Install. The installation process begins. This process could take several minutes.

Note After the installation completes, a NetBackup installation log file is generated. You 
can find this log file at your default TEMP directory. The following procedure 
explains how to verify your TEMP environment variable so you can locate the 
NetBackup Installation log file.

� Locating the NetBackup Installation log file for Windows 2000 systems

a. Select Start > Programs > Accessories > Command Prompt. A Command Prompt 
window appears. 

b. Enter echo %TEMP% and press the Return key on your keyboard. The location of 
your TEMP directory will display.

� Locating the NetBackup Installation log file for Windows NT systems 

a. Select Start > Settings > Control Panel. The Control Panel window appears. 

Note Make sure you can view all hidden files and folders. To set this option, select Tools 
> Folder Options... in the Control Panel window. Then click the View tab; set the 
Show hidden files and folders option, and click the OK button.

b. Double-click the System icon. The System Properties window appears.

c. Click the Environment tab. The Environment Variables including the TEMP variable 
will appear along with the corresponding paths for each variable. 

Note Remember to install this product in the exact location as the previous product.
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Uninstalling NetBackup Client Software 
For instructions on uninstalling NetBackup client software for the following platforms, 
refer to the NetBackup Installation Guide - PC Clients.

� Microsoft Windows 

� Macintosh

� Novell NetWare

Note Microsoft Windows clients include 95/98/ME/NT/2000/XP (32 and 64 bit)/LE.

� To uninstall UNIX NetBackup client software

1. Log on to the client system as the root user.

2. Remove the /usr/openv directory.

If /usr/openv is a physical directory, execute:

rm -rf /usr/openv

If /usr/openv is a link, execute:

cd /usr/openv
rm -rf *
cd /
rm -f /usr/openv

3. Remove NetBackup entries in the /etc/services file, as follows. 

a. Edit the client’s /etc/services file.

b.  Locate the lines marked by the following and remove them:

# NetBackup services#

.....

# End NetBackup services #

# Media Manager services #

....

# End Media Manager services #
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4. Remove the NetBackup entries in the /etc/inetd.conf file. For NCR this file is 
called inetd.local.

a.  Edit the client’s /etc/inetd.conf file.

b.  Delete the lines for bpcd, vnetd, vopied, and bpjava-msvc.

5. Execute the following two shell commands to cause inetd to read the updated 
inetd.conf (or inetd.local) file.

a. Enter the following.

For most UNIX clients:

ps -ea | grep inetd

For MacOS X 10.0, 10.1, and FreeBSD:

ps -ax | grep inetd

b. Run the kill command as follows. The process ID is the first number displayed 
in the output from the ps command.

kill -1 process ID

The ps command options may vary from one client platform to another.

6. For NetBackup-Java capable clients running the NetBackup-Java Administration 
Console, remove the NetBackup-Java state data by executing the following:

/bin/rm -rf /.nbjava

7. Inform users of this machine that they can remove their $HOME/.nbjava directory.

The $HOME/.nbjava directory contains application state information (for example, 
table column order and size) that is saved when the user exits NetBackup-Java 
applications.
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 A

This appendix lists and describes the technical manuals that pertain to NetBackup.

The CD-ROM for each NetBackup product has a copy of the related manuals in Adobe 
Portable Document Format (PDF). The PDF files are either in the root directory or the 
Docs directory on the CD-ROM. 

To view the PDF copies of the manuals, you need an Adobe Acrobat reader, which you 
can download from the Adobe web site at www.adobe.com. VERITAS assumes no 
responsibility for the correct installation or use of the reader.

Release Notes
NetBackup Release Notes for UNIX and Windows

Provides important information about NetBackup DataCenter and BusinesServer 
products on UNIX- and Windows-based servers, such as the platforms and operating 
systems that are supported and operating notes that may not be in the NetBackup 
manuals or the online help.

Getting Started Guides
NetBackup BusinesServer Getting Started Guide for Windows

Explains how to get NetBackup BusinesServer software installed and running on 
Windows-based platforms. 

Installation Guides
� NetBackup Installation Guide for PC Clients

Explains how to install NetBackup PC client software. The supported PC clients are 
Microsoft Windows, Macintosh, and Novell NetWare. 
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System Administrator’s Guides - Basic Product
� NetBackup DataCenter Installation Guide for Windows

Explains how to install NetBackup DataCenter software on Windows-based 
platforms.

System Administrator’s Guides - Basic Product
� NetBackup DataCenter System Administrator’s Guide for Windows

Explains how to configure and manage NetBackup DataCenter on a Windows server.

� NetBackup BusinesServer System Administrator’s Guide for Windows

Explains how to configure and manage NetBackup BusinesServer on a Windows 
server.

� NetBackup DataCenter Media Manager System Administrator’s Guide for Windows

Explains how to configure and manage the storage devices and media on Windows 
servers running NetBackup DataCenter. Media Manager is part of NetBackup 
DataCenter.

� NetBackup BusinesServer Media Manager System Administrator’s Guide for Windows

Explains how to configure and manage the storage devices and media on Windows 
servers running NetBackup BusinesServer. Media Manager is part of NetBackup 
BusinesServer.

System Administrator’s Guides - Agents and Options
� NetBackup for DB2 on Windows System Administrator’s Guide

Explains how to install, configure, and use NetBackup for DB2 on Windows.

For IBM DB2 version 5.2, you may also need the following manuals from IBM:

IBM DB2 Universal Database for NT Quick Beginnings Version 5.2

IBM DB2 Universal Database for NT Extended Enterprise Edition Quick Beginnings Version 
5.2

Cmd Ref IBM DB2 Universal Database Command Reference

For IBM DB2 version 6.1, you may also need the following manuals from IBM:

IBM DB2 Universal Database for NT Quick Beginnings Version 6

IBM DB2 Universal Database for NT Extended Enterprise Edition Quick Beginnings Version 
6
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Administration Guide:Design and Implementation Version 6

Administrative API Reference Version 6

Command Reference Version 6

Troubleshooting Guide Version 6

Quick Beginnings: Enterprise Extended Edition for Windows NT Version 6

Quick Beginnings for Windows NT Version 6

� NetBackup Encryption System Administrator’s Guide

Explains how to install, configure, and use NetBackup encryption software to provide 
file-level encryption of backups and archives.

� NetBackup for Informix System Administrator’s Guide

Explains how to install, configure, and use NetBackup for Informix to back up and 
restore Informix databases that are on a UNIX NetBackup client.

For this product, you may also need the following manual from Informix Software 
Incorporated:

Informix-Online Dynamic Server Backup and Restore Guide 

Informix-Online Dynamic Server Administration Guide 

� NetBackup for Lotus Notes System Administrator’s Guide for Windows

Explains how to install, configure, and use NetBackup for Lotus Notes to back up and 
restore Lotus Notes databases and transaction logs.

� NetBackup for Microsoft Exchange Server System Administrator’s Guide for Windows

Explains how to configure and use NetBackup for Microsoft Exchange Server to 
perform online backups and restores of Microsoft Exchange Server.

You may also need the following resources from Microsoft Corporation:

Microsoft Exchange Server whitepapers and FAQs (go to 
http://www.microsoft.com/exchange and search for "Disaster Recovery")

Microsoft Exchange Administrator's Guide

Microsoft Exchange Concepts and Planning Guide

Microsoft TechNet 

Microsoft BackOffice Resource Kit

http://www.msexchange.org
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� NetBackup for Microsoft SQL Server System Administrator’s Guide for Windows

Explains how to install, configure, and use NetBackup for Microsoft SQL Server to 
back up and restore Microsoft SQL Server databases and transaction logs.

For this product, you may also need the following manual from Microsoft 
Corporation:

Administrator’s Companion - Microsoft SQL Server

� NetBackup for NDMP System Administrator’s Guide

Explains how to install, configure, and use NetBackup for NDMP to control backups 
on an NDMP host.

� NetBackup for Oracle on Windows System Administrator’s Guide

Explains how to install, configure, and use NetBackup for Microsoft Oracle to back up 
and restore Oracle databases that are on a Windows NetBackup Client.

For this product, you may also need the following manuals from Oracle Corporation:

Oracle Enterprise Manager Administrator’s Guide

Oracle7 Enterprise Backup Utility Administrator’s Guide

Oracle8 Server Backup and Recovery Guide 

Oracle7 Enterprise Backup Utility Installation and Configuration Guide 

� NetBackup for SAP on Windows System Administrator’s Guide

Explains how to install, configure, and use NetBackup for SAP on Windows-based 
servers.

For this product, you may also need the following manuals from Oracle Corporation:

Oracle Enterprise Backup Utility Installation and Configuration Guide 

BC SAP Database Administration : Oracle

You may also need the following manual from SAP AG:

BC-BRI BACKINT Interface R/3 System, Release 3.x and 4.x
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� NetBackup for SYBASE on Windows System Administrator’s Guide

Explains how to install, configure, and use NetBackup for SYBASE to back up and 
restore Sybase databases that are on a Windows NT NetBackup client.

For this product, you may also need the following manuals from SYBASE 
Incorporated:

SYBASE SQL Server Installation and Configuration Guide

SYBASE SQL Server System Administration Guide

SYBASE SQL Server Utility Programs for Windows 95, Windows 98, and Windows NT

SQL Server Configuration Guide

� NetBackup Global Data Manager System Administrator’s Guide for UNIX and Windows

Explains how to install, configure, and use Global Data Manager (GDM) for 
NetBackup DataCenter and BusinesServer products on UNIX and Windows-based 
operating systems.

� NetBackup Vault System Administrator's Guide for UNIX and Windows

Describes how to configure and use logical vaults and profiles to duplicate backups, 
perform catalog backups, eject media, and generate reports.

� NetBackup Advanced Reporter System Administrator’s Guide

NetBackup Advanced Reporter (NBAR) is a backup and storage management 
monitoring tool designed to simplify the task of monitoring and reporting on an 
organization’s VERITAS NetBackup activities.

User’s Guides
� NetBackup User’s Guide for Mac OS

Explains how to use NetBackup on a Macintosh client to perform backups, archives, 
and restores. This guide also contains some configuration instructions for the 
NetBackup client software.

� NetBackup User’s Guide for Windows

Explains how to use NetBackup on a Microsoft Windows clients to perform backups, 
archives, and restores. This guide also contains some configuration instructions for 
the NetBackup Backup, Archive, and Restore software.
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Troubleshooting Guides
� NetBackup User’s Guide  for Novell NonTarget

Explains how to use NetBackup nontarget software on a Novell NetWare server to 
perform backups and restores. The nontarget version of NetBackup has a Microsoft 
Windows interface. This guide also contains some configuration instructions for the 
NetBackup Backup and Restore software.

� NetBackup User’s Guide for Novell NetWare Target

Explains how to use NetBackup target software on a Novell NetWare server to 
perform backups and restores. The target version of NetBackup has a menu driven 
interface that runs under DOS. This guide also contains some configuration 
instructions for the NetBackup client software.

� NetBackup Vault 4.5 Operator's Guide for UNIX and Windows

Describes procedures for sending tapes offsite, receiving tapes on site, and running 
reports on offsite media and vault jobs.

Troubleshooting Guides
� NetBackup Troubleshooting Guide for Windows

Provides troubleshooting information for Windows-based NetBackup DataCenter 
and BusinesServer products, including Media Manager.
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